Accounts Receivable Year-End Processing Guidelines

INTRODUCTION

This article outlines the recommended year-end closing procedures for the Microsoft Business
Solutions - Small Business Financials sales transactions. Read this document before you perform
any steps. If you have any questions, contact Microsoft Business Solutions Technical Support.

MORE INFORMATION

Detailed information about closing the sales year
Step 1: Post all Sales and Receivables transactions for the calendar year.

Step 2: Complete the Receivables month-end procedures.

1. On the toolbar, click Customers, point to Period-End Procedures, and then click Age
Customer Balances.

2. On the toolbar, click Customers, point to Period-End Procedures, and then click Assess
Finance Charges.

3. On the toolbar, click Customers, point to Period-End Procedures, and then click Print
Statements.
4, On the toolbar, click Customers, point to Period-End Procedures, and then click Move

Transactions to History.

Step 3: Create a backup, and make sure your data can be restored from the backup.

Create a backup, and store it on a safe, permanent storage medium. Creating a backup gives you a
permanent record of the company's financial position at the end of the year. If you later have to
restore the data, you can use this backup copy. A backup makes sure that you will be able to
quickly recover if a power fluctuation or other problem occurs during the year-end close procedure.

To create a back up, follow these steps:

1. On the File menu, click Backup. The Back Up Company dialog box opens.

2. In the Company Name list, click your company name.

3. Change the path of the backup file to the path that you want, and then click OK.

Step 4: Close the year by using the Close Receivables Year dialog box.

The calendar year

The following procedures will be automatically completed in the Customer Finance Charge
Summary dialog box when you close the calendar year:

e The Calendar Finance Charges Current Year amounts will be cleared and will be moved
to the Last Year field.



e The Next Year field will be cleared and will be moved to the Current Year field.

Note To view the Customer Finance Charge Summary dialog box, click Customers on the
toolbar, point to Customer Summary, type a customer ID in the Customer ID field, and then
click Finance Charges.
To close the sales calendar year, follow these steps:
1. On the toolbar, click Customers, point to Utilities, and then click Close Receivables
Year.

2. Click Calendar.

Note If your fiscal year and calendar year are the same, you can click All.

3. Click to select the Print Report check box, and then click Process.
The fiscal year
The following procedures will be automatically completed when you close the fiscal year:

. The Year to Date amounts will be cleared and will be moved to the Last Year field in the
Customer Summary dialog box for the Amounts Since Last Close view.

Note To view the Customer Summary dialog box, click Customers on the toolbar, click
Customer Summary, and then type a customer ID in the Customer ID field.

e The Fiscal Finance Charges Year-to-Date amounts will be cleared and will be moved to
the Last Year field in the Customer Finance Charge Summary dialog box.
Note To view the Customer Finance Charge Summary dialog box, click Customers on
the toolbar, point to Customer Summary, type a customer ID in the Customer ID field,
and then click Finance Charges.

e The Year-to-Date amounts will be cleared in the Customer Credit Summary dialog box.
Note To view the Customer Credit Summary dialog box, click Customers on the toolbar,

point to Customer Summary, type a customer ID in the Customer ID field, and then click
Credit Summary.

e The Calendar Finance Charges Current Year amounts will be cleared and will be moved
to the Last Year amount in the Customer Finance Charge Summary dialog box.

e The Next Year amount will be cleared and will be moved to the Current Year field in the
Customer Finance Charge Summary dialog box.
Note To view the Customer Finance Charge Summary dialog box, click Customers on the
toolbar, point to Customer Summary, type a customer ID in the Customer ID field, and then
click Finance Charges.

To close the sales fiscal year, follow these steps:

1. On the toolbar, click Customers, point to Utilities, and then click Close Receivables



Year.

2. Click Fiscal.

3.
4. Note If your fiscal year and calendar year are the same, you can click All.
5. Click to select the Print Report check box, and then click Process.

Step 5 (Optional): Close the fiscal periods for the Sales series.

You can use the Fiscal Periods Setup dialog box to close any fiscal periods that are still open for
the year. This prevents users from accidentally posting transactions to the wrong period or year.
Verify that you have posted all transactions for the period and for the year for all modules before
you close fiscal periods. If you must later post transactions to a fiscal period that you have already
closed, you can return to the Fiscal Periods Setup dialog box to reopen the period before you post
a transaction.

To close a fiscal period, follow these steps:

1. On the Setup menu, point to Company, and then click Fiscal Periods.

2. Click to select the Sales check box for the period that you want to close.

Step 6: Make a final backup.

Create a final backup. Store it on a safe, permanent storage medium. To create a backup, follow
these steps:

1. On the File menu, click Backup. The Back Up Company dialog box opens.

2. In the Company Name list, click your company name.

3. Change the path of the backup file to the path that you want, and then click OK.

Frequently asked questions about closing the sales year
Q1: Can I post sales transactions for 2006 if I have not yet closed 2005?

A1: If you post sales transactions for 2006 before you close 2005, the Amounts Since Last Close
view of the Customer Summary dialog box will not contain the correct year-to-date information.
These amounts may also be reflected in SmartLists and reports. Therefore, we recommend that you
not post any 2006 transactions before you close 2005.

Q2: My fiscal year and calendar year are not the same. When should I run the calendar
year-end close?

A2: We recommend that you close the calendar year after you post all calendar-year 2005
transactions but before you post any calendar-year 2006 transactions.



Accounts Payable Year-End Processing Guidelines

SUMMARY

This article describes how to close the fiscal year and the calendar year for payables (vendor)
transactions.

MORE INFORMATION
Understanding the Payables Year-End Close Process

The payables year-end close process consists of two parts: close the calendar year and close the
fiscal year.

- Closing the calendar year will transfer the Year to Date 1099 Amount field to the 1099
Amount Last Year field in the Vendor Yearly Summary window. All transactions for the calendar
year should be posted before closing the calendar year.

- Closing the fiscal year will transfer all other Year to Date amounts, other than the 1099
Amount, to Last Year in the Vendor Yearly Summary window. All transactions for the fiscal year
should be posted before closing the fiscal year.

Payables Calendar Year-End Closing Overview

. Post all payables transactions for the calendar year.

. Print 1099 statements using the 1099 Documents window (optional).
. Make a backup.

. Close the calendar year using the Close Payables Year window.

. Close the fiscal periods for the Purchasing series (optional).

. Make a final backup.
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Detailed Payables Calendar Year-End Closing Checklist
1. Post all payables transactions for the calendar year.
2. Print 1099 statements using the 1099 Documents window (optional).

If you are required by the U.S. Internal Revenue Service to send 1099 statements to one or more
vendors at the end of the year, you may print 1099 documents before closing the calendar year for
payables transactions. You may also print 1099 documents after closing the calendar year for
payables transactions.

Click Vendors, point to Utilities, and then click Print 1099s to open the 1099 Documents
window. Before you print 1099 statements, you can verify the 1099 information by printing the
1099 Edit List. To print this list, select Print on the File menu of the 1099 Documents window.

Vendor 1099 amounts are pulled from the 1099 Amount field in the Vendor Period Summary
window (click Vendors, click Vendor Summary, type a vendor ID, and then click Period). The
1099 Amount field is updated automatically when a 1099 invoice is paid. If you must adjust the
vendor 1099 amount that is printing on the 1099 statement, you may adjust the 1099 Amount
field for the appropriate Month/Period in the Vendor Period Summary window. This would be
required if a 1099 invoice was entered but a 1099 Amount was not entered in the Payables
Transaction Entry window (click Vendors, click either Bills/Invoices or Other Payables
Transactions).

See the Small Business Financials online Help for more information about printing 1099 statements.
3. Make a backup and make sure that this backup can be restored if it is needed.

Use your company's backup utility by clicking File, and then clicking Backup to back up your
company database and put it in safe, permanent storage. This gives you a permanent record of the



company's financial position at the end of the year and can be restored later if it is needed. The
year-end backup is important to make sure that you will be able to quickly recover should a power
fluctuation or other problem occur during the year-end close procedure.

4. Close the calendar year using the Close Payables Year window.

Click Vendors, point to Utilities, and then click Close Payables Year to open the Close
Payables Year window.

In the Close Payables Year window, select the Calendar option in the Year to Close section. If
the calendar year coincides with your fiscal year, select All. If they do not coincide, close the
calendar and fiscal years separately.

Mark the Print Report option to print the Payables Year-End Closing report after the closing
process is finished. This report lists the amounts that were transferred to Last Year for each vendor.
The Year-End Closing report is part of the audit trail and should be saved with your company's
permanent records.

5. Close the fiscal periods for the Purchasing series (optional).

You can use the Fiscal Periods Setup window to close any fiscal periods that are still open for the
year. This keeps transactions from accidentally being posted to the wrong period or year. Make sure
that you have posted all transactions for the period and year for all modules before closing fiscal
periods. If you later must post transactions to a fiscal period you have already closed, you will have
to return to the Fiscal Periods Setup window to reopen the period before you can post a
transaction.

To close a fiscal period, open the Fiscal Periods Setup window by clicking Setup, point to
Company, and then click Fiscal Periods. Type or select a year in the Year field. For any period
that you do not want to permit posting, you can mark the period for the appropriate Series. Click
OK to close the window.

6. Make a final backup.

Use your company's backup utility by clicking File, and then click Backup to back up your company
database and put it in safe, permanent storage. This gives you a permanent record of the
company's financial position at the end of the year and can be restored later if it is required.

Payables Fiscal Year-End Closing Overview

. Post all payables transactions for the fiscal year.

. Make a backup.

. Close the payables fiscal year using the Close Payables Year window.
. Close the fiscal periods for the Purchasing series (optional).

. Make a final backup.
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Detailed Payables Fiscal Year-End Closing Checklist

1. Post all payables transactions for the fiscal year.

2. Make a backup and make sure this backup can be restored if it is needed.

Use your company's backup utility by clicking File, and then click Backup to back up your company
database and put it in safe, permanent storage. This gives you a permanent record of the
company's financial position at the end of the year and can be restored later if it is required. The
year-end backup is important to make sure that you will be able to quickly recover if a power
fluctuation or other problem occurs during the year-end close procedure.

3. Close the fiscal year using the Close Payables Year window.

Open the Close Payables Year window by clicking Vendors, point to Utilities, and then click
Close Payables Year.



In the Close Payables Year window select the Fiscal option in the Year to Close section. If the
calendar year coincides with your fiscal year, select All. If they do not coincide, close the calendar
year and the fiscal years separately.

Mark the Print Report option to print the Payables Year-End Closing report after the closing
process is finished. This report lists the amounts that were transferred to Last Year for each
vendor. The Year-End Closing report is part of the audit trail and should be saved with your
company's permanent records.

4. Close the fiscal periods for the Purchasing series (optional).

You can use the Fiscal Periods Setup window to close any fiscal periods that are still open for the
year. This keeps transactions from accidentally being posted to the wrong period or year. Make sure
you have posted all transactions for the period and year for all modules before closing fiscal periods.
If you later have to post transactions to a fiscal period you have already closed, you will have to
return to the Fiscal Periods Setup window to reopen the period before you can post a transaction.

To close a fiscal period, open the Fiscal Periods Setup window by clicking Setup, point to
Company, and then click Fiscal Periods. Type or select a year in the Year field. For any period
that you do not want to permit posting, you can mark the period for the appropriate Series. Click
OK to close the window.

5. Make a final backup.

Use your company's backup utility by clicking File, and then click Backup to back up your company
database and put it in safe, permanent storage. The year-end backup gives you a permanent record
of the company's financial position at the end of the year and can be restored later if it is needed.

Payables Year-End Closing Tips

The following details explain information included in each box on the 1099 statements and the lines
and windows in Small Business Financials Setup which the information comes from:

- PAYERS name, street address, city, state, and ZIP Code is taken from the Company and Address
fields in the 1099 Documents window (Click Vendors, point to Utilities, and then click Print
1099s).

- RECIPIENTS name, address and ZIP Code are taken from the Main Address fields in the Vendors
window (Click Vendors, select List of Vendors, select a vendor from the list, click View, and then
select the Vendors window).

- RECIPIENTS identification number is taken from the Tax ID field in the Vendor Options window
(Click Vendors, select List of Vendors, select a vendor from the list, click View, select Vendors
window, and then click Options).

- ACCOUNT NUMBER field is optional. You can manually enter the account number on the 1099 form
itself.

- Boxes 1a through 6 pertain to the Dividends 1099 form. They are taken from the 1099 Amount
field in the Vendor Period Summary window (Click Vendors, select Vendor Summary, type or
select a Vendor ID, and then click Period).

Note We currently do not offer magnetic media filing of state 1099s.

Payables Year-End Questions and Answers

Q: Are inactive vendor records cleared during payables year-end closing? If not, how can inactive
vendor records be removed?

A: No, inactive vendor records are not automatically removed. To remove an inactive vendor record,
the record must not have a current year 1099 amount or any historical records. There cannot be



any saved or open payables transactions for a vendor to be inactive. After records have been
removed from history, a vendor can be deleted by using the Vendors window.

Q: I printed 1099 statements and some of the statements did not have the vendor name appearing
on them. What should I do?

A: When printing 1099 statements, the Check Name entered for the vendor in the Vendors
window (click Vendors, select List of Vendors, select a vendor from the list, click View, and then
select the Vendors window) will appear on the 1099 statement. If a vendor name is not appearing
on the statement, the Check Name field in the Vendors window is blank. Enter a Check Name for
each vendor in the Vendors window.



Inventory Year-End Processing Guidelines

SUMMARY
This article describes how to close the fiscal year for Inventory transactions.
MORE INFORMATION

When you complete procedures to close the fiscal year for inventory, you can remove records for
discontinued items, and item receipts and lot attributes that have been sold. Discontinued items
aren’t removed if they are assigned to kits. Item receipts for items that have been sold are records
of items that have been both received and then sold. Lot attributes that have been sold refers to the
information that you might have kept for items tracked by lot numbers—for example, if you track
the expiration dates for items tracked by lots. In this case, deleting lot attributes that have been
sold would remove the information about the expiration dates of the sold items.

Use the procedures described in this section to close the year for Inventory and prepare your
Inventory records for the new fiscal year.

Inventory Fiscal Year-End Closing Overview

. Post all inventory transactions for the fiscal year.

. Reconcile inventory quantities.

. Complete a physical inventory count and post any adjustments.
. Print additional reports.

. Make a backup.

. Close the Inventory fiscal year.

. Close the fiscal periods for the Inventory series (optional).

. Make a final backup.
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Detailed Inventory Fiscal Year-End Closing Checklist
1. Post all inventory transactions for the fiscal year.
2. Reconcile inventory quantities.

Reconcile quantities for all inventory items using the Reconcile Items window (click Inventory, point
to Utilities, select Reconcile Items) to ensure that that your Inventory data has not become
damaged over the course of the year. If any discrepancies are found during the reconcile process,
the quantities will be adjusted. If adjustments are made, they'll be reflected on the Item Reconcile
Report, along with any serial numbers and lot humbers that were added to the adjusted items. If
you want to edit these serial and lot numbers, you can use the Item Adjustment Entry window (click
Inventory and select Adjust Item Quantities) to do so by making adjustment transactions.

3. Complete a physical inventory count and post any adjustments.

Print a Physical Inventory Checklist (click Inventory and select Reports) and perform a physical
count of your inventory items to verify that quantity on hand amounts are accurate for all items. If
discrepancies exist, enter the necessary adjustments in the Item Adjustment Entry window (click
Inventory and select Adjust Item Quantities) and post them.

4. Print additional reports.

Print any additional reports you'll need for planning or for your permanent records, including the
Stock Status Report and Purchase Receipts Report. Use selections from the Inventory reports list
(click Inventory and select Reports) to print these reports. If you plan to remove sold purchase
receipts during the year-end closing process in step 6, we recommend that you print the Purchase
Receipts Report to review the receipts that will be removed.

5. Make a backup and ensure this backup can be restored if needed.



Use your company's backup utility by clicking File, then click Backup to backup your company
database and place it in safe permanent storage. This gives you a permanent record of the
company's financial position at the end of the year and can be restored later if necessary. This is
important to ensure that you'll be able to quickly recover should a power fluctuation or other
problem occur during the year-end close procedure.

6. Close the inventory year.

Closing the inventory year accomplishes the following tasks:

- Removes any discontinued items from the item records that have been completely sold.
- Removes purchase receipts for items that have been completely sold.

- Removes any lot attributes from the records of lot humbered items if they've been completely
sold.

Use the Close Inventory Year window (click Inventory, point to Utilities, click Close Inventory Year)
to close the year. In the Close Inventory Year window, select records to remove. Options include
Discontinued Items, Sold Receipts, and Sold Lot Attributes. Click Process to complete fiscal year-end
inventory closing procedures. No report will be printed. Close the window.

Use the following descriptions to learn more about each option in the Close Inventory Year window:

Remove: Discontinued Items - If you mark the Discontinued Items option, all discontinued items
that have a zero balance will be removed during the year-end closing process. Note - Items can be
designated as discontinued by setting the Item Type field to 'Discontinued Item' in the Items
window (click Inventory, select List of Items, select an item, click View, select Items window).
Discontinued items that have a quantity on hand of zero (except for kit components), and do not
have any un-posted transactions, will be completely removed from the Inventory module.

Remove: Sold Receipts - If you mark the Sold Receipts option, all sold receipts whose quantity
received and quantity sold amounts are equal will be removed. This is an optional step and may not
be a procedure that is done every year-end. These values may be helpful when items are returned
through the Sales series so you may not want to remove sold receipts.

Remove: Sold Lot Attributes - If you mark the Sold Lot Attributes option, values for completely sold
Lot Numbers will be removed. For example, you can remove the value red for the lot attribute color
if you've sold all lot numbered items that have been assigned the value red.

Note - While the year is being closed, you won't be able to post, reconcile quantities, change cost
methods or change decimal places for items.

7. Close the fiscal periods for the Inventory series (optional).

You can use the Fiscal Periods Setup window to close any fiscal periods that are still open for the
year. This keeps transactions from accidentally being posted to the wrong period or year. Be sure
you've posted all transactions for the period and year for all modules before closing fiscal periods. If
you later need to post transactions to a fiscal period you've already closed, you'll need to return to
the Fiscal Periods Setup window to re-open the period before you can post a transaction.

To close a fiscal period, open the Fiscal Periods Setup window by clicking Setup, point to Company,
and click Fiscal Periods. Type or select a year in the Year field. For any period that you do not want
to allow posting, you can mark the period for the appropriate Series. Click OK to close the window.
8. Make a final backup.

Use your company's backup utility by clicking File, then click Backup to backup your company
database and place it in safe permanent storage. This gives you a permanent record of the
company's financial position at the end of the year and can be restored later if necessary.

Inventory Year-End Closing Tips



- When closing the year you have the option of marking Discontinued Items, Sold Receipts, or Sold
Lot Attributes. If marked, all discontinued items, sold receipts, or sold lot attributes that have a zero
balance will be removed during the year-end closing process.

- There is no Year-End Closing report for Inventory.






Fixed Assets Year-End Processing Guidelines

Year-end checklist

1. Perform all year-end closing procedures for the Payables Management module.

Close the Payables Management module first. This action guarantees that all outstanding fixed asset
transactions are capitalized. For more information about closing the Payables Management module,
click the following article number to view the article in the Microsoft Knowledge Base:

857424 Payables transactions year-end close checklist for Small Business Financials

2. Enter all fixed asset transactions for the current fiscal year.
Post all additions, changes, transfers, and retirements for the current fiscal year.

Note Transfers and undo retirements should never be performed in a historical year.

3. Depreciate all assets through the last day of the current fiscal year.

a. Point to Accounting, point to Fixed Assets, and then click Depreciate Many Assets.
b. In the Depreciation Target Date box, type the last day of the current fiscal year.
C. Click All.

d. Click Depreciate.

4. Process the GL Posting (GL Interface) routine.

a. Point to Accounting, point to Fixed Assets, point to Utilities, and then click General
Ledger Posting.

In the Beginning Period box, type 2005-012.

b.

C. In the Ending Period box, type 2005-012.

d. In the Transaction Date box, type 12/31/2005.

e. Click Continue.

f. When you receive the message that a batch number is being created, click Continue.

g. In the Report Destination dialog box, click to select the Printer check box, and then click

OK.

Note You may want to keep this report as part of your year-end financial records.

5. Run any year-end reports that you want to keep as part of your year-end financial
records.

The year-to-date depreciation amounts for previous fiscal years are not kept in the Fixed Asset
Management module. Therefore, you must print any reports that contain this information before you
close the year.

There are several reports available for fixed assets. We recommend that you print the following
reports:

° Annual Activity



° Additions

. Retirements

. Transfers

e Depreciation Ledger

. Fixed Assets to GL Reconciliation

If you have more than one fixed asset book, we recommend that you also print the following
reports:

. Book to Book Reconciliation

° Book to Book YTD Comparison

To print any one of the fixed asset reports, point to Accounting, point to Fixed Assets, and then
click Reports.

6. Verify that the quarters are set up correctly for all fiscal years.

a. On the Setup menu, point to Fixed Assets, and then click Quarters.

b. Make sure that the following boxes are not empty:

e Start Date
e Mid Date
¢ End Date

These boxes must exist for each quarter. If any box is empty, type the appropriate date in
that box.

7. Create a backup.

This backup should be stored off-site together with the rest of your year-end documentation. This
backup gives you a permanent record of the company's financial position at the end of the year.
This record can be restored later if it is required. Making a backup guarantees that you will be able
to quickly recover should a power fluctuation or other problem occur during the year-end closing
routine.

To create a backup, follow these steps:

a. On the File menu, click Backup.

b. In the Company Name list, click your company name.

8. Perform the fixed assets year-end closing routine.



a. Point to Accounting, point to Fixed Assets, point to Utilities, and then click Year End.

b. Verify that the fiscal year that is displayed for each book is the current fiscal year. (The
current fiscal year is the year that you are closing.)

Note If the fiscal year that is displayed is the previous fiscal year, the Fixed Asset
Management module for the previous fiscal year has not yet been closed. If the fiscal year
that is displayed is the next fiscal year, the Fixed Asset Management module for the current
fiscal year has already been closed.

C. Click to select the fixed assets books that you want to close, and then click Close Year.
Note Great Plains performs the following procedures during the year-end routine:

1. In the Assets dialog box, the Quantity field is copied to the Begin Quantity field.

2. In the Expand Last Maintenance dialog box, the YTD Maintenance amount is
cleared.

In the Asset Book dialog box, the YTD Depreciation Amount is cleared.

4. The following procedures are performed:
e The Cost Basis field is copied to the Begin Year Cost field.

e The LTD Depreciation field is copied to the Begin Reserve field.

e The Salvage Value field is copied to the Begin Salvage field.

5. The Fiscal Year field is increased by one for each fixed asset book that is closed.

Note A report is not generated during the fixed assets year-end closing routine.

9. Print any additional year-end reports, and then verify that the year-end closing
procedures have been successfully completed.

Frequently asked questions (FAQ) about the Fixed Asset Management year-
end closing procedures

Q1: I have closed the General Ledger module, but I have not closed the Fixed Asset
Management module. Is it too late to close the Fixed Asset Management module?

Al: We recommend that you close the General Ledger module only after you have closed all
subsidiary modules. For more information about the recommended General Ledger year-end closing
procedures, click the following article number to view the article in the Microsoft Knowledge Base:
874067 Accounting transactions year-end close checklist for Small Business Manager

The Fixed Asset Management module can be closed after you close the General Ledger module. The
general ledger posting process can be performed. The transactions can then be posted to the closed
year in the General Ledger module. The posted transaction updates the historical year and rolls
forward as a beginning balance to the open year for beginning balance accounts. If any expense or
any revenue accounts were included in the transaction, the amounts for those accounts will
automatically transfer to the Retained Earnings account or accounts.

Q2: You ran the year-end routine in the Fixed Asset Management module, and then you
ran depreciation in the new year. You notice that the depreciation is highly overstated
and that some of the assets have a negative number in the "Net Book Value" field. Why is
the system calculating so much depreciation?

A2: This problem occurs if the following conditions are true:



e The year was closed.

e The assets were not depreciated through the last day of the fiscal year.

Consider the following example:

e The fiscal year is a calendar year (January 1 through December 31).

e The assets were depreciated through December 28 when the year was closed.

In this example, depreciation will be incorrect the next time that depreciation is run. The system
does not recalculate the yearly rate when the year-end procedure is performed. Therefore, fixed
assets will take a full year of depreciation in the last few days remaining in the previous year
(December 29 through December 31). The rate of depreciation will be the yearly rate currently on
each asset. Additionally, if there are assets near the end of their original life, the Net Book Value
field may become negative.

There are two workarounds for this problem:

¢ Recommended workaround
Restore the data from a backup, run depreciation through the last day of the year, and then
perform the year-end closing procedures.

e Alternative workaround
Reset life on all the assets.

Note If amounts on the assets have ever been entered for the YTD Depreciation field or
for the LTD Depreciation field, resetting life on the assets will change those amounts, and
the result may be different. If you change the YTD Depreciation field or the LTD
Depreciation field by resetting life on the asset, you will cause inconsistencies between the
Fixed Asset Management module and the General Ledger module. These inconsistencies
must be explained.



Payroll Year-End Processing Guidelines

INTRODUCTION

Read this whole article before you perform any one of the steps. If you have any questions, contact
Microsoft Business Solutions Technical Support. More information for the Payroll module is typically
included in the Year-End Update file documentation. To locate updated year-end information, click
Help, point to Products and Services, and then click Check for Year-End Updates.

MORE INFORMATION

Payroll year-end checklist

Verify the version of Microsoft Small Business Financials

The 2005 Payroll Year-End Update file and the 2006 Payroll Tax Update file are available for
Microsoft Small Business Financials 8.0 and for Microsoft Small Business Manager 7.5 only. To view
the program version number, click Help, and then click About Microsoft Business Solutions
Small Business Financials. The 2005 Payroll Year-End Update file and the 2006 Payroll Tax
Update file are not compatible with versions of Microsoft Small Business Financials that are earlier
than version 7.5.

Complete all pay runs for the current year

Complete all monthly and quarterly payroll period-end procedures for the current
year

For more information about period-end procedures for payroll, view Chapter 14, "Payroll Company
Routines," in the Small Business Financials Payroll user's manual.

(Optional:) Close the fiscal periods for the payroll series

You can use the Fiscal Periods Setup dialog box to close any fiscal periods that are still open for
the year. By closing fiscal periods, you prevent users from accidentally posting transactions to the
wrong period or to the wrong year.

Before you close a fiscal period, verify that you have posted all transactions for the period and for
the year for all modules. To later post a transaction to a fiscal period that you have closed, you
must first reopen the period in the Fiscal Periods Setup dialog box.

To close a fiscal period, follow these steps:

1. On the Setup menu, point to Company, and then click Fiscal Periods.

2. Click to select the Payroll check box for the period that you close.

Make a backup of the original file

Create a backup, and then put this backup into safe, permanent storage. By creating a backup, you
make sure that you have a permanent record of the company's financial position at the end of the
year. You can restore the backup to quickly recover data if a power fluctuation or other problem
occurs during the year-end closing procedure.

To create a backup, follow these steps:

1. On the File menu, click Backup. The Back Up Company dialog box opens.

2. In the Company Name list, click your company name.



3. Change the path of the backup file if it is required, and then click OK.

Install the payroll year-end update

To install the year-end update, you must complete these steps on each computer that has Microsoft
Small Business Financials installed:

1. On the Help menu, point to Products and Services, and then click Check for Year-End Updates.

2. In the Payroll Year-End Update dialog box, click Automatic, and then click Next.

3. In the Authorization Number field of the Log on to Customer Source for Year-End Update dialog

box, type your authorization number.

Note If you are prompted for a user name and password, click Payroll Update Engine to install the

PUE.exe file. If that link does not work, you can click the following link to access the file:

https://mbs.microsoft.com/customersource/support/downloads/taxupdates/sbm pue.htm?printpage=false

4. In the Payroll Year-End Update dialog box, click Finish.

Note You may also install 2005 tax update files from the following alternative location:
https://mbs.microsoft.com/Cms/Templates/document/ServicePacks.aspx?NRMODE=Published&NRO
RIGINALURL=/customersource/support/downloads/taxupdates/SBF802005TaxUpdate.htm&NRNODE
GUID={F1A45CCA-E873-45BF-8AA8-02A9A0C4D91A}Y&NRCACHEHINT=Guest

Create the year-end file
To create the year-end file, follow these steps:

1. On the toolbar, click Payroll, point to Utilities, point to Year-End Procedures, and then
click Create Year-End.

In the Year field, type 2005, and then click Process.

Note The payroll tax update for 2006 can be installed any time after the year-end file for 2005 has
been created.

Make a backup of the new file

Create a backup, and then put this backup into safe, permanent storage. By creating a backup, you
make sure that you have a permanent record of the company's financial position at the end of the
year. You can restore the backup to quickly recover data if a power fluctuation or other problem
occurs during the year-end closing procedure.

Verify company information
To verify the company information that will print on W-2 statements, follow these steps:

1. On the toolbar, click Payroll, point to Utilities, point to Year-End Procedures, and then
click Company Information.

2. View and validate the following fields:

¢ Company Name

e Address



. City

o State
e ZIP Code
e EIN

Verify W-2 and 1099-R statement information

To view the W-2 information, click Payroll, point to Utilities, point to Year-End Procedures, and
then click View W-2s.

To view the 1099-R information, click Payroll, point to Utilities, point to Year-End Procedures,
and then click Edit 1099-Rs.

Note If you change the W-2 or the 1099-R information, we recommend that you make another
backup.

Print the W-2 statements and the W-3 Transmittal form
To print the W-2 statements, follow these steps:

1. On the toolbar, click Payroll, point to Utilities, point to Year-End Procedures, and then
click Print W-2s.

2. In the W-2 Printing Options dialog box, click Year-End W-2s, and then click Next.

3. In the Print W-2s dialog box, click Print All Employees, and then click Next.

In the Starting Control Number field, type 001.

Note This step is optional. However, we recommend that you enter this value so that you
have an internal control number for each W-2 copy that you print.

5. Click Print.
Note You can print the employee W-2 statements as many times as you have to.

To print the W-3 Transmittal Form, follow these steps:
1. On the toolbar, click Payroll, point to Utilities, point to Year-End Procedures, and then
click Print W-3s.
2. In the W-3 Transmittal dialog box, click Print.

Note You can print the W-3 Transmittal Form as many times as you have to.
Print the 1099-R forms and the 1096 Transmittal form
To print the 1099 forms, follow these steps:

1. On the toolbar, click Payroll, point to Utilities, point to Year-End, and then click Print
1099-Rs.

2. In the 1099-R Printing Options dialog box, click Year-End 1099-Rs, and then click
Next.



3.

4,

In the Print 1099-Rs dialog box, click Print All Employees, and then click Next.

Click Print.

Note You can print the employee 1099-R forms as many times as you have to.

To print the 1096 Transmittal form, follow these steps:

1.

2.

On the toolbar, click Payroll, point to Utilities, point to Year-End, and then click Print
1096.

In the 1096 Transmittal dialog box, click Print.

Note You can print the 1096 Transmittal form as many times as you have to.

(Optional:) Create a magnetic media file
To create a magnetic media file, follow these steps:

1.

On the toolbar, click Payroll, point to Utilities, point to Year-End Procedures, and then
click Print W-2s.

In the W-2 Printing Options dialog box, click Create Magnetic Media file, and then
click Next.

In the Reporting Year field, click 2005, and then click Next.

In the Company Information dialog box, click Next.

In the Submitter Information dialog box, click Next.

In the Miscellaneous Information dialog box, click Next.

In the Select Companies dialog box, click to select the check boxes for the companies for
which you want to create magnetic media files. Then click Next.

In the PIN field, type the PIN that is assigned to the employee who is authorized to submit
the magnetic media file.

Change the location destination of the file if it is required. Then click Create File.

Close the payroll year
To close the payroll year, follow these steps:

1.

2.

On the toolbar, click Payroll, point to Utilities, point to Year-End Procedures, and then
click Close Year.

In the Year list, click 2005, and then click Process.



Note After 2005 payroll year is closed and the tax updates for 2006 are installed, you can process
pay runs for 2006.

Set up fiscal periods for 2006
To set up fiscal periods for 2006, follow these steps:

1. On the Setup menu, point to Company, and then click Fiscal Periods.

2. In the Year field, type 2006, and then click Calculate.
Note You may want to close all periods except for period 1 to prevent users from posting

to future periods.

3. Click OK.
Install the payroll tax update for 2006
Notes
e You must complete these steps on each computer that has Microsoft Small Business
Financials installed.
° Do not install the payroll tax update for 2006 until the year-end file has been created for
2005.
To review this step, click this link:

Create the year-end file

To install the payroll tax update for 2006, follow these steps:

1. On the Help menu, point to Products and Services, and then click Check for Payroll Tax Updates.

2. In the Tax Update Method dialog box, click Automatic, and then click Next.

3. In the Authorization Number field, type your authorization number, and then click Log in.

Note If you are prompted for a user name and a password, click Payroll Update Engine to install the
PUE.exe. If that link does not work, you can click the following link to access the file:

https://mbs.microsoft.com/customersource/support/downloads/taxupdates/sbm pue.htm?printpage=false

4, Click Finish.
4+ Back to the top

Frequently Asked Questions
Question 1: What does the payroll transactions year-end close do?

Answer 1: The process of closing the year in the Payroll module clears the year-to-date financial
information for all employees.

You must close the payroll year after you create the year-end file and before you process pay runs
for 2006.



Note You must not re-create the wage file after you process payroll for 2006. If you do this, the
wage file will be incorrect.

Question 2: Can I process a pay run for 2006 before I print my 2005 year-end reports?

Answer 1: To process a pay run for 2006 before you print the 2005 year-end reports, follow these
steps:

1. Verify the version of Microsoft Small Business Financials

2. Complete all pay runs for the current year

3. Complete all monthly and quarterly payroll period-end procedures for the current year
4. (Optional:) Close the fiscal periods for the payroll series

5. Make a backup of the original file

6. Install the year-end update

7. Create the year-end file

8. Make a backup of the new file

9. Verify company information

10. Verify W-2 and 1099-R statement information

11. Close the payroll year

12. Set up fiscal periods for 2006

13. Install the payroll tax update for 2006

14. Process the pay run for 2006.

15. Print the W-2 statements and the W-3 Transmittal form

16. Print the 1099-R forms and the 1096 Transmittal form

17. (Optional:) Create a magnetic media file

Question 3: I did not close my 2005 payroll year before I processed my 2006 pay runs. I
now see that my year-to-date amounts for my employees are incorrect. What should I
do?



Answer 3: To correct the year-to-date amounts, follow these steps:

1.

5.

Make a backup. To do this, follow these steps:

a. Open the Back Up Company dialog box. To do this, click File, and then click
Backup.
b. In the Company Name list, click your company name.

c. Change the path of the backup file if it is required, and then click OK.

Void all 2006 paychecks. To do this, follow these steps:

a. On the toolbar, click Payroll, and then click Void Checks.
b. Click to select all checks that you must void.
c. Click Void.

Create the year-end file. To do this, follow these steps:

a. On the toolbar, click Payroll, point to Utilities, point to Year-End Procedures, and
then click Create Year-End.

b. In the Year field, type 2005, and then click Process.
Close the payroll year. To do this, follow these steps:

a. On the toolbar, click Payroll, point to Utilities, point to Year-End Procedures, and
then click Close Year.

b. In the Year list, click 2005, and then click Process.

Re-enter the checks that were voided for the current year.

Question 4: I closed my payroll year, but my year-end information included pay runs from
both 2005 and 2006. What should I do now?

Answer 4: To correct this situation, follow these steps:

1.

Make a backup. To do this, follow these steps:

a. Open the Back Up Company dialog box. To do this, click File, and then click
Backup.

b. In the Company Name list, click your company name.

c. Change the path of the backup file if it is required, and then click OK.

Adjust the prior year information for the W-2s. To do this, follow these steps:

a. On the toolbar, click Payroll, point to Utilities, point to Year-End Procedures, and
then click View W-2s.

b. Use the Browse buttons to navigate among records. Click Edit W-2 to change a W-2.
Adjust the prior year information for the 1099s. To do this, follow these steps:

a. On the toolbar, click Payroll, point to Utilities, point to Year-End, and then click
Edit 1099-Rs.



b. Use the Browse buttons to navigate among employee IDs.

Delete history information that is on the checks that were entered before the payroll year
was closed. To do this, follow these steps:
a. On the toolbar, click Payroll, point to Utilities, and then click Delete History.

b. In the Clear history from starting posting date field, type the start date of the
period that should be in 2006, but that was posted before the payroll year was closed.

c. In the Clear history to ending posting date field, type the end date of the period
that should be in 2006 but in which checks were posted before closing the year, and
then click Process.

Re-enter the checks that were deleted in step 4. Do not post this batch in the General
Ledger.

Delete the duplicate checks in Banking. To do this, follow these steps:

a. On the toolbar, click Banking, and then click Other Transactions.
b. In the Option list, click Void Transaction.
c. In the Checkbook ID list, click the appropriate payroll checkbook.

d. In the Number field, enter the number of the first check that you must void. If you
are prompted by a warning that the transaction should be voided in another module,
click OK.

e. For the offset account, enter the checkbook cash account number so that the net
effect in the General Ledger is zero.

f. Click Void.

g. Repeat steps 6¢-6f for each additional check that you must void.

Verify that the numbers are correct for the 2006 year. The Monthly Payroll Summary report
can be used to verify this information. To print the Monthly Payroll Summary report, follow
these steps:

a. On the toolbar, point to Payroll, and then click Reports.

b. In the Reports dialog box, click Monthly Payroll Summary.

Click Preview.
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d. In the Month list in the Period-End Report dialog box, click January, and then click
Print.



Closing Fiscal Year Guidelines

INTRODUCTION

This article discusses how to close the fiscal year in Microsoft Business Solutions Small Business
Financials.

MORE INFORMATION

Note If you do not close the current fiscal year, you can still enter transactions in the general
ledger for the next fiscal year. You can leave one or more fiscal years open. However, until you
close the fiscal year, financial statements for the new fiscal year may be inaccurate. For example,
the beginning balance for the new fiscal year is created at the end of the year-end closing process.
If you do not close the fiscal year, financial statements for the new fiscal year will show activity for
the current year only.

Fiscal year closing procedure
To close the fiscal year, follow these steps:

1. If the general ledger is not integrated with other modules, go to step 2. If the general
ledger is integrated with other modules, follow these steps:

Post final transactions in all modules.

b. For each module, complete the month-end procedures, and then complete the
quarter-end procedures.

c. Close the fiscal year for receivables transactions.

For more information, click the following article number to view the article in the Microsoft
Knowledge Base:

874253 Year-end closing procedures for the Microsoft Small Business Financials
Receivables transactions

2. Close the fiscal year for payables transactions.

For more information, click the following article number to view the article in the Microsoft
Knowledge Base:

857424 Payables transactions year-end close checklist for Small Business Financials

3. Close the fiscal year for inventory transactions.

For more information, click the following article number to view the article in the Microsoft
Knowledge Base:

857808 The year-end closing procedures for the Small Business Financials Inventory
Control transactions

4. Close the fiscal year for sales taxes.

For more information, click the following article number to view the article in the Microsoft
Knowledge Base:

861968 Year-end closing procedures for sales taxes in Microsoft Small Business Financials



Note The year-end procedures for the Payroll module are independent of the year-end
procedures for other modules. We recommend that you always close payroll at the end of
the calendar year.

Post adjustments in the general ledger.

Enter standard and reversing transactions. Also, enter correcting transactions to correct
errors in any posted transactions. To do this, click Accounting on the toolbar, and then
click Journal Entry.

Enter accounting transactions by using quick journal IDs that you have set up. To do this,
click Accounting on the toolbar, and then click Quick Journal Entry.

Verify that the posting type for each account is correct.

The posting type determines whether an account is closed to the retained earnings
account or the balance is carried forward to the next fiscal year. If the account balance
must be brought forward at the end of the fiscal year, the account must have a Balance
Sheet posting type. If the account balance will be closed to a retained earnings account at
the end of the fiscal year, it must have a Profit and Loss posting type.

To verify the posting type of an account, click SmartList on the View menu, expand the
Accounting folder, and then expand the Accounts folder.

To change the posting type for an account, click Accounting on the toolbar, and then
click Accounts.

(Optional:) Close the fiscal periods for the Financial series.

Close any fiscal periods that are open. This prevents users from posting transactions to
the wrong period or to the wrong year.

Before you close a fiscal period, make sure that you post all transactions for each period
in the year, and then post all transactions for the year. Post these transactions for all
modules. To do this, follow these steps:

On the Setup menu, point to Company, and then click Fiscal Periods.
b. In the Year field, type or select a year.

c. If you do not want to enable posting for a period, click to select the check box that
corresponds to the period and to the series that you want.

d. Click OK.

If you must post a transaction to a fiscal period that you closed, reopen the period.

Verify data in related tables in the Financial series.

a. On the File menu, point to Data Maintenance, and then click Check Links.
b. In the Series list, click Financial.

Click All.

Click OK.

a o



10.

11.

12.

13.

Back up your company database.

a. On the File menu, click Backup.

b. In the Company Name list, click the appropriate company, and then click OK.

Print a year-end detailed trial balance report.
To print a year-end detailed trial balance report, follow these steps:

a. On the toolbar, click Accounting, and then click Reports.

b. Select one of the trial balance detail reports, and then click Print.

Print year-end financial statements.
The most common financial statements include the following:

e Balance sheet
e Profit and loss
e Cash flow

e Retained Earnings

To print a financial statement, follow these steps:

a. On the toolbar, click Accounting, and then click Reports.
b. Select the report that you want, and then click Print.

Set up the new fiscal year.

To set up the new fiscal year, follow these steps:

On the Setup menu, point to Company, and then click Fiscal Periods.

a
b. In the Year list, type or select the year that you want.

c. In the First Day box, type the first day of the period.
d. In the Last Day box, type the last day of the period.
e. In the Number of Periods box, type the number of periods in the fiscal year.

f. Click Calculate.
g. Click OK.

Close the fiscal year.
To close the fiscal year, follow these steps:

a. On the toolbar, click Accounting, point to Utilities, and then click Close Fiscal
Year.

b. In the Retained Earnings Account list, type or select the account that you want.

By default, the account that is selected is the one that you entered in the Transaction
Setup window.



c. In the Starting Journal Entry box, type the number that you want to use for the
first journal entry in the next fiscal year.

By default, the number that appears in the Starting Journal Entry box is one more
than the last number that is used for a journal entry in the previous year. The year-
end closing reports use this number.

d. Click Close Year.

Note The year-end closing process might appear to stop responding before it is
completed. Do not interrupt the process.

When the year-end closing process is completed, the year-end closing report will be
printed. The report lists the accounts that are closed and the transactions that are
used to close the accounts. Retain the year-end closing reports together with your
company’s permanent records.

14. Adjust budget figures for the new fiscal year. Then print the financial statements. To do
this, click Accounting, and then click Budgets.

15. Change the fiscal year on the financial statements that you print. Use one of the following
methods to change the fiscal year on the financial statements.

Method 1

a. On the toolbar, click Accounting, and then click Reports.

b. In the Report list, select the report that you want to modify, and then click Modify
Report.

c. Change the year, and then click Save.

Method 2

a. On the Tools menu, click Advanced Financial Report Layout.

b. In the list of reports, click the report that you want to update, and then click Open.

c. Click Layout. Make the changes that you want.

After you change the fiscal year, verify that the profit and loss and balance sheet accounts

are closed to retained earnings. Also verify that the balance is carried forward in the
balance sheet accounts.

16. Back up the company database.

Make a new backup copy of the company database after you close the fiscal year. Keep
the backup copy in a safe location in case you must restore the backup later.

Additional Information

You do not have to perform the year-end closing process immediately at the end of the year.

Although you typically make adjustments before you close the fiscal year, you can make
adjustments after you close the fiscal year. Adjustments that you make after you close the fiscal
year are posted to the most recent closed year. If you make an adjustment to a closed year,
Microsoft Small Business Financials automatically adjusts the beginning balance.



Frequently Asked Questions (FAQ)

Q1: When the year-end closing process completed, why were the beginning balances for
some of my revenue and expense accounts not carried forward?

A1: This problem may occur if the posting type for the account is incorrect. For revenue and
expense accounts, select the Profit and Loss posting type. To change the posting type for an
account, click Accounting on the toolbar, and then click Accounts.

If you must make corrections after the fiscal year is closed, restore the data from the backup that
you made before you closed the fiscal year. Then change the posting type for the account. To
change the posting type, click Accounting on the toolbar, and then click Accounts.

Q2: Can other users be logged on to Microsoft Small Business Financials when I perform
the year-end closing process?

A2: Yes. Other users must log off from Microsoft Small Business Financials when you close the fiscal
year.

Q3: I want to allocate my net profit to my retained earnings account or to a capital
accounts monthly. Also, net profit is supposed to be allocated to three different retained
earnings or capital accounts. Is this possible?

A3: No. However, you can set up a non-financial account in the Accounts window. To do this, click
Accounting, and then click Accounts. You must use a number that is not used in your current
account numbering scheme. This account will act as a holding account for the net income or loss. A
holding account is sometimes referred to as a "suspense account."

You can post adjustments to the three capital accounts each month. Use the holding account for the
offset account. When the year-end closing process is completed, use the holding account for the
retained earnings account to offset the manual adjustments that you made to the holding account
during the year. Make sure that the holding account is not included on your reports.

When you format the balance sheet, put the net profit line at the end of the Advanced Financial
Analysis statement, and then put a page break above it. The balance sheet requires an NP (net
profit) line. However, by including the NP line, the balance sheet shows the net income (loss) two
times. Therefore, the NP line should be formatted so that it is off the financial statement.
Alternatively, you can use a report type of Other that does not require a net profit line.

Q4: What happens to the balance in a non-financial account when I close the fiscal year?
A4: If the non-financial account is a balance sheet account, the balance will be carried forward
when you close the fiscal year. If the non-financial account is a profit and loss account, the balance
will be closed to retained earnings when you close the fiscal year.

Q5: Please explain the meaning of the following message:

A single-use batch or quick journal transaction has not been posted yet.

A5: This message means that you have transactions in the general ledger that were not posted
before you began the year-end closing procedure. To continue the year-end closing procedure, you
must post the existing transactions. To do this, follow these steps:

1. In the message, click Cancel.

2. Click Accounting, and then click Post Batches.
If you do not have to post the transactions before you close the fiscal year, click Continue.

Q6: What do I do if the year-end closing process for the general ledger stops responding
before it is completed?



AG6: If the hard disk sounds as if it is processing, let it continue. If the hard disk does not sound as if
it is processing, follow these steps:

a. Cancel the year-end closing procedure.

b. Restore your backup.

C. Examine the links in all the Financial series tables.
d. Restart the year-end closing procedure.

Q7: If I post an adjustment to a closed year, can I print a corrected trial balance report
for that year?

A7: Yes. To print a report that shows the adjustments to the closed year, follow these steps:

1. On the toolbar, click Accounting, and then click Reports.

2. Select one of the Trial Balance Detail reports.

3. Click Options. Specify the options that you want.

4. In the Year list, click History, and then click the closed year.

Q8: How does Microsoft Small Business Financials determine which financial statement to
use to print my account statements?

A8: The selection of the statement is determined by the category that you define in the Accounts
window. To view or to change the category, click Accounting, and then click Accounts.
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